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It is an important rule that print-ready files are accepted only in PDF format (preferably at least PDF X-1a). Files should be 
created in single-page layout, which means that a single page of the completed file should be a single physical page. Please 
do not submit spreads except if you design a jacket that includes a spine or other elements that you configured and designed 
yourself. Since PDF files are considered closed, i.e. they cannot be changed, it cannot occur that the layout of the submitted 
text file changes due to different font sets.
We will not perform any content check in the submitted files (e.g. spelling mistakes, layout errors, displaced pictures etc.), 
unless otherwise agreed in writing. Codex Zrt. is not liable for files not in accordance with the submission conditions, and 
for the resulting potential errors.
Of course, if the customer is unable to submit closed and perfect PDF files, we can fix such files based on prior consultation, 
but in this case we will charge a graphic preparation fee, and the customer must approve the material prepared 
by us before sending to production. This approval means the verification and the approval of the digital print (not color 
corrected, and not prepared in accordance with the imposition) or of the imposed digital PDF files we have made.

Please note that the delivery date specified in our quotation is calculated from the availability of the perfect closed PDF file 
necessary for the production, or from the approval of the digital print or of the imposed digital PDF file – if we get an open 
or incorrect file.

– How to create a PDF file?

There are several ways to prepare PDF files. Many people export their files into a PostScript file and then generate a PDF 
from it. In case of newer program versions (Quark 7-10, Adobe CS3-6, ...), we recommend that you export to PDF directly 
from the program.
Each of the two methods are acceptable, however, in order to prepare the correct PDF file from PostScript, you also need 
the correct PS driver, while in the case of PDF exporting, you will only need to set a few parameters correctly. We will check 
incoming files in all cases, and inform the customer about the errors accidentally left in them.
The recommended settings in the Export Adobe PDF dialog are as follows

– Requirements for print-ready files

• composite PDF files must conform to one of the PDF/X-1a, or PDF/X-4 are prefered 
• the submitted material should include only the files necessary for the production of the product
• the file should be created in single-page layout, which means that a single page of the completed file should be a single 

physical page
• spreads are required only for covers (with adjusted spine size and extra symbols)
• PDF file names should possibly refer to the job name and the pages contained in the file (e.g. Yearbook 1-50.pdf, Yearbook 

cover.pdf)
• all fonts and images should be embedded, the PDF file should contain only CMYK (device-specific), greyscale and spot 

colors, the trimbox (crop marks) and bleed should be defined, and trapping should be set

– Images

• CMYK or greyscale, minimum 300 dpi for raster images. (You can also check the resolution of the images with the 
Preflight function in Adobe Acrobat 7 or over versions – using a variety of control presets {preflight profiles}.)

• Use JPG compression for images only at the maximum quality setting; we recommend using the lossless ZIP algorithm

CODEX Zrt. – 
Material submission criteria and guidelines

– What kind of files can the printing house accept?

– Fonts

• all fonts have to be embedded or vectorized (converted to outline ) in order to avoid problems with e.g. accented letters. 
Files that do not contain embedded fonts cannot be processed. (Fonts used in the document can be checked with the 
Document Properties/Fonts command in Adobe Acrobat: embedded or not embedded.)

– Colors

• the submitted PDF file should only contain the CMYK and spot colors to be printed (except for die-cutting , where they 
must be spot colors)

• only those colors should be defined as spot colors in the document that are required to be printed as spot colors (spot 
colors can be checked with the preview function in Adobe Acrobat)

• 100% black graphic elements, line art and text placed on color background should be set as overprint
• small black graphic elements, line art and text should be present only on the black color separation

– Pages, bleed

• pages are combined by us according to the imposition, so we need single pages (not double-page) in the PDF file that 
follow each other according to reading order (1, 2, 3 ...)

• for multi-page booklets – where possible – please submit the whole booklet in one PDF file
• for adhesive binding jobs, please submit the cover in a separate PDF file with a double-page layout, indicating the spine 

size
• please adjust the page size (trim size)
• if the publication contains blank pages, they should be included in the PDF file as well.
• your PDF file should contain bleeds (of min. 3 mm each side), i.e., areas outside the trimmed page which will be cut during 

the manufacturing process, and also crop marks Due to the characteristics of the printing equipment, if any graphical 
elements (picture, shading, etc.) extend to the edge of the page, then these graphical elements should extend beyond the 
crop mark.

• For hardcover publications, the bleed should be at least 15 mm as the cover is folded back onto the reverse side of the 
cover board

 
 

• Die-cut materials (Booklet, ECL, boxes)
Particular attention should be paid to those jobs which will be die-cut during binding. It is very important to specify the 
precise die-cut information. Die line drawings should only contain 100% spot colors, or preferably a color that will not 
be printed. Never make die line drawings as part of the four-color separation. If possible, die lines should not appear as a 
separate file, but embedded in the material, as vectors.
Die lines should always be set to overprint. This setting is available in any vector graphical or desktop publishing software. 
The correct settings for the die lines can be checked easily with the Output Preview option in the Advanced menu of 
Adobe Acrobat Professional.
Your die line is drawn correctly if the die line is invisible when you remove the die line color, and disabling the color does 
not affect the graphics that should be printed.

• Varnish form, embossed areas and die lines
Please always use spot color for them in the submitted file. Such elements should not be submitted in a separate file, but 
as part of a composite PDF file in order to provide verifiability.

– How can you submit a job for us 

– Submission channels and storage media for digital material; a few examples
• e-mail, FTP
• CD/DVD
• USB, Flash Drive
• external HDD (IDE, SATA, Firewire)
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• az előírt címketartalom (termékösszetétel,  
figyelmeztetés, felhívás stb.) esztétikus és praktikus 
megjelenítésére

• a nemzetközi és nemzeti előírásoknak megfelelő 
adatok és információk olvasható formában történő 
feltüntetésére

• a gyártó/forgalmazó által közölni kívánt információk 
elhelyezésére
  használati/kezelési utasítás
  műszaki/technikai adatok
  részletes termékismertető
  a gyártó/forgalmazó egyéb termékeinek  

bemutatása
  tanácsok, receptek stb. 

• újszerű marketing megoldások alkalmazására
  nyereményakciók
  a címke belső oldalain elhelyezett kód alapján 

regisztrációhoz kötött játékok stb.

• nyomdai biztonsági elemek alkalmazásával  
a hamisítás elleni hatékony védekezésre 

• és még számtalan innovatív, figyelemfelkeltő  
megoldás alkalmazására

Az ECL® több, mint a hagyományos címke, 
 mert megsokszorozza annak információhordozó felületét, 

ezáltal akár több nyelven is  lehetőséget biztosít az alábbiakra:

Extended Codex Label
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– Typical file errors

The following guidelines will help you when exporting PDF files and checking the completed PDFs. 
Because of the complexity of PDFs, it is not always easy to eliminate or fix errors in the finished file, so it is advisable to get 
to know the root causes and eliminate them early in the open file.

The errors cannot be fixed, and no products with satisfactory quality can be manufactured

The errors can be fixed with additional expense, but there is a chance that the product will not match the 
expectations of the customer

Problem Possible result Can be 
fixed?

Solution Approval
 required

1. Superfluous registration marks Trimmed size will not be correct No YesPlease do not use marks 
other than crop marks

2. No bleed Trimmed size will not be correct No YesUse 3 mm of bleed on 
all edges of the document

3. Font is not embedded Character errors No YesAll fonts have to be embedded or 
vectorized (converted to curves)

4. Low resolution images Printed images will be jagged No YesCMYK or greyscale, minimum 300 dpi
for raster images.

5. Content near the trim line Trimmed size will not be correct No Yes
Place content elements that will not extend into

the bleed at least 3 or 4 mm from the trim line that
indicates the place where the cuts will be made

6. Page cannot be identified Collation problems No YesPDF file names should refer 
to the pages contained in the file

7. Die lines are 
      incorrectly adjusted Problem with die-cutting No Yes

Elements of the die lines should be placed 
on a spot color channel, with a color name 

that is not used for printing

Problem Possible result Can be 
fixed?

Solution Approval
 required

8. Color separation is not adequate Problems with printing Yes Yes
The file should contain only CMYK, 

greyscale and spot colors

9. Page size is incorrect Variation in size Yes Yes
The final trimmed size should be identical 

to the size indicated in the order

10. Crop is not defined Variation in size Yes YesThe trim box should be adjusted

11. Incorrect color space (ICC) Color difference Yes YesUse the proper ICC color profile

12. Incorrect color space (RGB) Color difference Yes Yes
Images in the submitted material have to be 
converted from RGB color space into CMYK

Correction is required to ensure proper printing results

Problem Possible result
Can be 
fixed? Solution Approval

 required

13. Black thin lines, small graphic 
elements are definied in CMYK but 
not K channel only, or definied in RGB

Problems with printing Yes Yes
Small black graphic elements and line art should 

be present only on the black color separation

14. Wrong overprinting 
      (punching, thin rules)

Problems with printing Yes Yes
Black text, thin rules, barcode, etc. should 

always be set to overprint if they 
cover some other objects

15. Total ink coverage is too high Problems with printing Yes Yes
The total percentage of fill rate should not 

exceed 280% for the color separations 
(CMYK) printed on each other



4. LOW RESOLUTION IMAGES
The higher the dpi value, the higher the resolution and the 
better picture quality we can get.
Please make your document in original (1:1) size, with a mini-
mum resolution of 300 dpi, in order to avoid quality loss for 
the printed products. It is important to select the correct 
image materia l, because if a picture does not already contain 
sufficient detail (for example, images downloaded from the 
Internet), however hard we will try to increase the resolution 
in an editing program later, the result will not be any better.
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2. NO BLEED
Bleed is the area beyond the actual size of the printing 
product, where the background color, graphics, or – depending 
on the design –, product images should be extended.

In order to avoid errors:
• use 3 mm of bleed on all edges of the document
• Please place crop marks, folding marks, color
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3. FONT IS NOT EMBEDDED
To avoid errors resulting from font conversions, please 
embed all fonts for the text content in your document after 
the completion of the design or convert them to curves 
during PDF making.
When converting text to curves, make sure that spaces in the 
text and basic fonts (Arial, Courier, Times New Roman) will 
also be converted to curves.
Please do not use font sizes smaller than 6 pt during the 
design process.  

A korrekten beágyazott 
(embeded) szöveg a 
nyomtatás során is 
korrekten jelenik meg! 
Amennyiben semmilyen
átalakítást nem igényel az 
anyag, akkor a görbévé 
alakított szöveg is használ-
ható!

A korrekten be�gyazott 
(embeded) sz�veg a 
nyomtat�s sor�n is 
korrekten jelenik meg! 
Amennyiben semmilyen
�talak�t�st nem igényel az 
anyag, akkor a g�rb�v� 
alak�tott sz�veg is haszn�l- 
hat�!

1. SUPERFLUOUS REGISTRATION MARKS 
Please do not use marks other than crop marks.
Our printing house uses its own auxiliary marks, which differ 
from the ones offered by the editing software. These 
superfluous marks only create confusion as they usually take 
up much needed millimeters from the bleeds on the pages, 
which are absolutely necessary in terms of the production 
technology.
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5. CONTENT NEAR THE TRIM LINE 
The red lines indicate the trim line in the figures below. On the figure to the right, content items are too close to the trim 
positions, and there is a risk that some important elements may be cut off due to trimming fluctuations of 1-2 millimeters 
arising from the technology. It is advisable therefore to place important content items that are not intended for bleed at least 
3-4 millimeters from trim.
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8. COLOR SEPARATION IS NOT ADEQUATE
Please create your print material in CMYK mode, with a color depth of 8-bit/channel in all cases.
Content in RGB color mode are automatically converted during the printing process, which may not always result the colors 
expected. We take no responsibility for printing errors if the material is submitted in RGB color mode. Please convert all 
elements to CMYK mode, except for spot colors. Also keep other marks and drawings required for further processing (e.g. 
die lines) in spot color.
Check the spot color setting in the finished PDF file by turning off the color channel containing the spot colors in the Output 
Preview menu item of Adobe Acrobat Professional.

6. PAGE CANNOT BE IDENTIFIED
If your publication does not contain page numbers and the 
exact location of a particular page in the publication is not 
exactly clear based on the names of the submitted file, then it 
will be difficult to identify the pages – thus there is a risk that 
we may not find the correct page sequence – so if you do not 
submit the full publication with all pages in one PDF file, then 
please pay particular attention to name the files clearly (e.g. 
Inside 09-96.pdf, Inside 12-36.pdf). 3

2

1

?

?

?

Correct page numbers No page numbers

 

7. DIE LINES ARE INCORRECTLY ADJUSTED
It is important to set the elements of the die line drawing to 
overprint as this ensures that an inverted version of the die 
line will not appear in the print after turning off the separation 
containing the die line drawing.
It is essential for the production of the punching tool that the 
die lines properly fit the graphics, but they should be separa-
ted in the file, because none of the die lines should appear 
when printing. The easiest way to ensure this is to place die 
lines elements in a spot color channel with a color name 
which is not used for printing (e.g. punching).
The die line setting in the finished PDF file can be checked by 
turning off the color channel containing the die line drawing in 
the Output Preview menu item of Adobe Acrobat Professional.
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10. TRIM IS NOT DEFINED 
Essentially there are two ways to define the trim. On the one 
hand, you can indicate the location of the trim with a drawn 
trim mark. This is less desirable as it reduces the bleed (see 
Item 1), so we do not support it.
The other option is to use a trim box. In the graphic applica-
tion, the size of the document (page) should always be identi-
cal to its final trimmed size, which makes it easy to use the 
correct trim box setting. It is advisable to add the correct trim 
box setting to the PDF file as metadata, indicating clearly the 
place of the trim. This trim box size can be interpreted by the 
PDF workflow software used at the printing house, and the 
crop marks will always be placed automatically to the correct 
position.



9. PAGE SIZE IS INCORRECT 
Page size is considered incorrect for a file when the final 
cropped size specified in the file differs from the one specified 
in the purchase order submitted to us. Page size is also incor-
rect when the exact trimming location cannot be clearly 
determined in the publication (see item 10).

Colors outside of the color space 
after RGB – CMYK conversion 

12. INCORRECT COLOR SPACE (RGB) 
RGB or CMYK? Presses operate in CMYK color space while 
cameras and monitors work in the RGB color system. The 
colors that can be displayed by the two systems are different. 
The conversion may typically change the colors, so it is very 
important that the conversion does not occur in the printing 
house, but in the initial phase of image editing, in order to set 
the colors in the appropriate color space. Images in the 
submitted final should be defined in CMYK.
When you convert colors, always make sure you use the 
correct color profile settings. A misconfigured ICC color 
profile may produce unexpected colors in printing..
 

„A hamisított áruk a világkereskedelem  
teljes mennyiségének 5-7%-át teszik ki.” 

(Counterfeiting Intelligence Bureau of the International Chamber of Commerce) 

A hamisítás nagyobb probléma,
mint ahogy többen gondolják...
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www.codex.hu
éve a hamisítás ellen

ISO Coated v2 (ECI).icc U.S. Web Coated v2 (ECI).icc

11. USING THE CORRECT OUTPUT PROFILE ( ICC PROFILES ) 
Printing colors can be simulated accurately when looking at 
the file on a calibrated monitor and using the correct color 
profile. This gives you the opportunity to correct the images 
still in the retouch phase for the best look.
The color space is incorrect, when color separation is not 
performed based on the ICC color profile corresponding to 
the printing technology or to the paper to be used in printing.
It is a frequent mistake that color separation is performed by 
leaving the default settings of graphic software set to the U.S. 
Web Coated (SWOP) color profile, which is incompatible 
with the European standards and leads to unexpected diffe-
rences in color.
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„A hamisított áruk a világkereskedelem 
teljes mennyiségének 5-7%-át teszik ki.”

(Counterfeiting Intelligence Bureau of the International Chamber of Commerce) 

15. TOTAL INK COVERAGE IS TOO HIGH 
In sheetfed offset technology, it is not very good when the 
total percentage of ink coverage for color separations 
(CMYK) printed on each other exceeds 280%. A total ink 
coverage of more than 300% may already result in severe 
printability problems. For this reason, please avoid using 
image elements of this kind. If you need to print elements in 
deep black color on a large area, then we recommend that 
the coverage of such areas should be K:100% + C:40%.
The color separation (total coverage) of each area can easily be 
checked with the Output Preview tool in Adobe Acrobat Professional.





13. THIN OBEJCTS IN CMYK OR RGB 
During the printing process the separated colors will be 
printed on media sequentially, on top of each other, rendering 
the perfect color on prints. It is very important to keep the 
position of color separations accurate – that is the registra-
tion. During the printing, moisture reaches the print as well, 
so there is a risk of an eventual paper stretch. Because of this, 
certain image areas may be more sensitive to color matching. 
Such elements are thin lines, drawings in multicolor (CMYK 
colors printed over each other) or thin inverse lines on multi-
color surfaces. For better printability, avoid using multicolor 
or set negative on multicolor background of lines thinner than 
0.2 pt, and small point size, or thin, light letters.

C:     0%
M:     0%
Y:      0%
K:  100%

C: 100%
M: 100%
Y: 100%
K: 100%

 

14. OVERPRINT IS NOT SET (THIN LINES, DIE-CUT CONTOUR) 
A graphic element is overprinted when it does not affect the 
fill of underlying objects. If something is not overprinted, then 
it will knock out the other object below it. Depending on the 
graphic conception and the desired visual effect, both cases 
can be considered good or bad. Keep in mind that elements 
that are not overprinted may not always match accurately 
because of paper stretching. Therefore, lower grade black 
text, thin rules, barcode, etc. should always be set to over-
print if they cover some other objects. However, setting 
“white colored” objects to 'overprint' should be avoided as 
this would make them disappear in the print. For die line 
drawings, it is particularly important to always set the 
elements of the die line drawing to 'overprint'.
You should turn on the display mode ‘Overprint Preview’ in your 
graphics program as this can simulate the results of overprint 
settings.

 



General
Entering basic file settings

1: Standard
Primarily this is recommended because PDF/X is a PDF 
format specifically used in printing. When used, the range 
of selectable parameters is narrow, which ensures that no 
disturbing and unnecessary content will get in the final file.

2: Pages
By default do not use the Spreads option (except, e.g. 
for covers), as imposition will be done by the printing 
house. It is advisable to create the PDF file with separate 
pages.

3: Interactive Elements
All interactive elements are unnecessary for the 
printing process.

PDF/X-3
(2002)

CMYK +
Spot, kalibrált
RGB, Lab 

For workflows using Color Management
Acrobat 5.0 /
PDF 1.4 

 

PDF/X-4
(2007)

CMYK +
Spot, kalibrált
RGB, Lab 

For workflows using Color Management 
Acrobat 7.0 /
PDF 1.6 

PDF/X-1a
(2001) 

CMYK + Spot

Transparency allowed, 
multilayer. 

Transparency allowed, 
multilayer.
 

No transparency, single layer. For workflows without Color Management 
(CMYK + Spot values only) 

Acrobat 4.0 /
PDF 1.3 

PDF/X
Version

Content Use Compatibility Other

Composite PDF files submitted to our printing house must conform to one of the PDF/X standards.

1

2

3

– PDF exporting guidelines

When you save a document as an Adobe PDF file, you can choose whether you want to create a PDF/X-compliant 
file. PDF/X files (Portable Document Format Exchange) are a type of Adobe PDF that removes many variables regar-
ding colors, fonts and overfilling which may cause printing problems. PDF/X files can be used where PDF files are 
transmitted to printing as digital originals – it can equally be carried out either in the creation or in the processing 
phase of the workflow, provided that the applications and output devices all support the PDF/X standard.

PDF EXPORT 
In order to be effective, ensure the right end product and minimize the errors, please use the recommended settings in the 
File> Export menu window of the Adobe CS and CC software series as detailed below.



8

7

6

Marks and Bleeds

6: Crop Marks
Only the crop marks should be selected. The program 
will automatically adjust the crop marks to the trim box 
sizes that have been set.

7: Offset
The distance of crop marks from the trim line, the recom-
mended value is 3 mm.

8: Bleed
The area outside the trim mark, which will be cut off during 
production, is called 'bleed' – must be minimum 3 mm.

11

10
9

Color management and PDF/X output

9: Color Conversion
In order to prevent that e.g. RGB images won’t be included 
even accidentally in the PDF file, it is recommended to 
select the option Convert to Destination (Preserve 
Numbers).

10: Destination
Specify the color profile of the CMYK output device (prin-
ting press). The ICC color profile corresponding to the 
printing technology or to the paper to be used in printing 
has to be selected (see page 14).

11: Profile Inclusion Policy
Profile Inclusion Policy – when selected, the ICC color profi-
le of the output color space will be embedded in the file, 
i.e., it will be part of the file.

5

4

Compression and Downsampling 

During PDF export, images can be compressed or their 
resolution reduced. Depending on the settings, compres-
sion and downsampling can significantly reduce the size of 
PDF files with little or no reduction in detail and precision. 

4: Color Images (Színes képek)
Images must have a minimum resolution of 300 dpi. Do 
not use images with a resolution higher than 450 dpi 
in order to avoid unreasonably large files that would only 
complicate file processing.

5: Compression ZIP
From the several compression options available, we 
recommend the lossless ZIP option instead of JPG comp-
ression.



Security

When you save a PDF file, you can assign password protec-
tion and set security restrictions. Processing password-pro-
tected PDF files is not possible; the PDF/X standard prohib-
its its use.

Megjegyzés: A fenti beállítások segítséget kívánnak nyújtani ofszetnyomta- 
tási technológiához megírt PDF-ek helyes elkészítéséhez. Azonban természe- 
tesen a fenti beállításoktól eltérő módon megírt PDF-ek is lehetnek nyomdai 
feldolgozásra alkalmasak.

12

Advanced (Special)

12: Subset Fonts
Enter the embedding threshold for the full font set based on 
the actual number of characters written into the document 
from the font in question. If the per-centage of characters 
from a font exceeds the threshold in the document, the 
entire font is embedded. Otherwise, only a subset of the 
font will be embedded. Embedding complete fonts increa-
ses the file size. Every font should be completely embed-
ded: enter the value of 0. 



– PDF checking guidelines 

Adobe Acrobat Professional also provides some support for 
the verification of the exported PDF files and the detection of 
certain common errors (View > Tools > Print Production). 
Prior to file submission, these tools should definitely be used, 
since the printed product can only be manufactured in the 
required quality from a properly prepared PDF file.

1: Output Preview
Visual inspection with simulation.

You can simulate with the tools and controls of the dialog 
box Output Preview how the PDF document would look 

like under different conditions.

2: Preflight
 Software based checks using profiles.

The Preflight function determines by analyzing the content 
of the PDF document if the file fulfils the criteria for printing 

production, and many other user-defined criteria

 

PREFLIGHT CHECK 
This preliminary check compares the file with the Preflight 
profiles (using userdefined values). The preflight test also 
checks the visible areas and certain objects, and ensures 
that the PDFs comply with various standards. For example, 
the preflight check identifies problems with colors, fonts, 
transparency, image resolution, ink coverage and PDF 
version compatibility. The Preflight function also includes 
tools by which the PDF syntax or the actual PDF structure 
in the document can be examined. After running a profile, 
you get a list of result from which you can determine which 
PDF parameters deviate from those configured in the profi-
le. As the properties of the PDF document depend on the 
parameters of the finished printed product (number of 
colors, paper type, printing technology), there are multiple 
profiles from which you can always select the one that is the 
most suitable for the parameters of the given product.

1: Imported Profiles
You can use your own custom profiles or profiles created 
by others. Test and control conditions can be customized as 
needed in the profiles.
If you have no experience in creating profiles, then we abso-
lutely recommend downloading and importing the Codex 
General Preflight Profile that we created.
 
2: SheetSpotHiRes_1v4 (Prepress Profiles)
Depending on the profile, certain errors can be corrected 
automatically by the preflight function. You can see a tick 
icon in front of such profiles. Standard preflight profiles are 
available that meet various standards and technologies.

3: Run
After selecting a profile, click on the Analyze button to run 
the check without error correction; if you click on the Run 
button (analyze and fix) the program will also identify and 
fix the problems.

3

2

1

2

1



Keep in mind that this software check function cannot replace 
visual inspection, all the more so because the production of 
comprehensive preflight profiles is rather difficult due to the 
diversity of printed products and the structural complexity of 
PDF files.
In addition, the checking of certain process conditions (e.g. 
ECL or Flexo) is difficult or even impossible to carry out with 
the help of profiles. Be aware that even if the software inspec-
tion does not find any problem in the PDF file based on the 
profiles, it does not necessarily mean that the file meets the 
requirements and contains no errors!

VISUAL CHECKS (OUTPUT PREVIEW)
Another important tool for checking PDF files is the Output 
Preview feature, because it can be used, in addition to the 
Preflight checks, to examine the completed PDF file if the 
correct color values have been used.

1: Simulation of colors to be printed on screen
Choosing the profile of the intended output you can check 
the printed preview on screen. You can use other control 
settings for better simulation (e.g. overprint, black ink, 
paper color simulation).

2: Show
You can set in the Show menu which objects are to be 
displayed (e.g., text, crop marks, bleeds over Acrobat 9 
version).

3: Separations
You can switch between the view of individual color separa-
tions and color warnings. Some types of errors can easily be 
detected (e.g., black texts or die lines are not set to over-
print, or spot colors are not separated).

4: Total Area Coverage (TAC)
The coverage of a specified area can be checked, the 
percentage values of area coverage appear in the ink list 
next to the ink names.

5: Total Area Coverage (TAC)
When checking the coverage of the entire document, you 
can identify those areas where ink coverage exceeds a 
certain percentage value previously specified.
The entire area coverage should not exceed the desirable 
limit (280%). Too much ink can cause drying and set-off 
problems due to the ink absorbing capacity of the paper, or 
it can change the color characteristics of the document.
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– COLOR MANAGEMENT

The production of the printed product with the expected quality requires a controlled manufacturing process, with color 
management as an essential part of it. Color management takes into account and compensates the effects of materials 
involved in image reproduction, input and output devices and changing conditions in order to ensure the predictability of 
the expected outcome. When used, it makes the result appearing on the finished product predictable already before 
production.

ICC Color profiles

Our printing house works with color management processes commonly used in the industry, based on ICC color profiles 
developed byFOGRA Forschungsgesellschaft Druck e.V. and published by the European Color Initative (ECI, www.eci.org), 
according to the ISO 12647-2 standard.
Our customers are kindly asked to create their print-ready PDF files taking into account the following ICC pro-files tailored 
to various print media.

Sheet-fed offset printing  
ISO Coated v2 (ECI) Glossy and matte coated papers

PSO Uncoated ISO12647 (ECI) Uncoated papers

Roll digital printing (Xeikon)

ISO Coated v2 (ECI) Coated paper rolls

PSO LWC Improved (ECI) Improved LWC, MWC papers

PSO LWC Standard (ECI)  Conventional LWC papers

SC Paper (ECI) SC paper rolls

PSO MFC Paper (ECI) MFC papers

ICC Profil

ICC Profil

ICC Profil

ICC Profil

ICC Profil



Color Management settings

The PDF workflow software for professional printing 
supports the color settings. In addition to selecting ICC color 
profiles, several other settings are available that can signifi-
cantly influence the color separation of the files or the colors 
of images displayed on the monitor. Keep in mind that these 
settings can only be used properly on your monitor when it is 
calibrated using an instrument (spectrophotometer).
In the case of Adobe software versions (Adobe CS3-6, CC) 
central color management settings are available under the 
menu Edit > Color Settings.

Recommended settings:
1: Working space RGB
Here you can set the RGB color space for the application. In 
general, Adobe RGB or sRGB profile should be used instead of 
a specific device profile (e.g. DO NOT use the profile of the 
monitor).

2: Working space CMYK
Here you can set the CMYK color space for the application. 
All CMYK working spaces are device dependent, which 
means that the ICC color profile appropriate to the manufac-
turing technology of the product and to the print media has to 
be used in all cases.

3: Color Management Policies CMYK
When using the setting Convert to Working Space, the 
elements using the CMYK color space will be converted 
according to the color profile set up for the work space.

4: Color Management Policies
We recommend checking all three tick boxes. This will ensure 
that the program will give you a warning, for example in cases 
when you open or insert an image into the working space that 
has a different color space or does not have a color profile, 
which may cause an incorrect color conversion.

The settings of the Color Setting dialog can be saved and 
loaded in the future to allow a central handling of the color 
management conversion of your images.
 

Color Management when creating a PDF file

The color settings will have to be used through the entire workflow. The settings must be adequate both during the creation 
and editing of the file, and the writing of the PDF file. In case of Adobe software versions, settings associated with PDF writing 
can be found in the Output section.










3: Profile Inclusion Policy
You can specify the color profile to be embedded into the PDF file. Embedding is automatic in the case of PDFs created 
according to higher version PDF/X standards.
It is advisable to choose color profile embedding, because this allows us to check if color profiles are appropriate in the PDF 
files sent to the printing house.

Recommended settings 

1: Color Converison
When converting colored objects into CMYK color channels, 
you must select the output color profile from the drop-down 
list. Information on the spot colors is preserved during color 
conversion; only their equivalents with basic printing colors 
are converted to the specified color space.

2: Destination
When selecting Convert To Destination, all the elements of 
the file will be saved in the selected output color profile 
(Destination) during PDF file producing.
You should select the proper ICC color profile for the combi-
nation of the printing machine and the paper. For example, if 
the product is printed on coated paper sheets in a sheet-fed 
offset machine, then select the profile ISO Coated v2 300% 
(ECI).

Recommended settings 

1: Proof Colors
If you select this option, the selected ICC color profile will be 
used not only for color separation, but also for displaying your 
file on the monitor. It must always be selected. Of course, you 
need to use a properly calibrated monitor.

2: Proof Setup > Custom
Customize Proof Condition dialog. Settings related to proper 
color display.

Recommended settings: 

1: Device to Simulate
You should select the proper ICC color profile for the combi-
nation of the printing machine and the paper.
 
2: Display Options – Simulate Paper Color
In order to avoid the influence on our color sense, it should 
always be checked. Otherwise the whitest point on the 
product will not be the white color of the printing paper, but 
the whitest color of the monitor. In case of CMYK files, the file 
should be in the same color space as the proofed color space.

Color matching while editing

Continous check of the output of the job is very important task in design stage. In graphical applications there are several 
object features and functions were not intended for printing directly. There is discrepancy
between the output files on monitor, and printing of the files. Transparency modes, overprint are the most known features. 
It is very useful when you can constantly monitor your work already in the editing process and you can see what the future 
result will be. To this end, you should also be aware of the display settings – in addition to the correct color management 
settings.
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The recommended settings in the Export Adobe PDF dialog are as follows:



Recommended settings:

1: Simulation Profile
You should select the proper ICC color profile for the combi-
nation of the printing technology and substrate.
 
2: Simulate Overprinting
You can check the outcome of overprint settings. Should be 
selected.
 
3: Simulate Paper Color
Should be selected. Otherwise the whitest point on the prod-
uct will not be the white color of the printing paper, but the 
whitest color of the monitor, which modifies our sense of 
color.

Color matching display of the exported PDF file

We have already mentioned the importance of visual inspection (Output Preview) – in relation to checking the finished PDF 
files.
Adobe Acrobat Professional provides the opportunity to customize the options for the color correct display of the produ-
ced PDF using the ICC color profile associated with intended output.

- Installing ICC color profiles to computers

ICC color profiles – which are simple binary files – should be in the correct system folder of the computer so that the 
Adobe programs can use them through the operating system.

Windows: Windows > System32 > Spool > Drivers > Color 

Mac OS X (from 10.4): Library > Colorsync > Profiles








